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Introduction  
 

 
MOS provides powerful control that can be used to manage a Thunder or Lightning in an AP ENPS 

environment.  But what exactly MOS is, and how it allows communication between various machines is an 
oft-confusing subject.  This paper will attempt to clarify the concepts and implementation of MOS, with 
special care taken to explain how MOS relates to Pinnacle Systems’ Thunder Production Clip Server and 
Lightning Image Management System. 

Sections in this paper will describe the benefits of MOS, outline the general scheme for data flow in 
MOS, and explain in detail how to configure MOS and ENPS on a Thunder Production Clip Server or 
Lightning Image Management System and how Thunder Browse integrates with ENPS.  

Appendices include excerpts from the MOS protocol website’s MOS Frequently Asked Questions, 
with the kind permission of Mike Palmer (Director of Technology/Development, Associated Press, and 
acting moderator of the MOS Group); excerpts from ENPS Questions & Answers obtained from the ENPS 
website with the kind permission of Lee Perryman (Director of Broadcast Technology, Associated Press); 
and instructions for obtaining IP addresses.  

The information presented here is equally applicable to Pinnacle Systems Lightning Image 
Management System or Thunder Production Clip Server, the latter of which can store both clips and stills.  
However, for clarity the text will use Thunder with reference to either system and use the term “clip” with 
reference to either a clip or still, except where differentiations must be made. 
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Background 
 

Definitions  
 
NCS is an acronym for Newsroom Computer Systems, a generic term for a news production system that 

includes computer and video equipment. 
The NCS is used for the creation, modification, and deletion of editorial information, 

including playlists.  An NCS consists of a server, client workstations, and broadcast devices.  Clips, 
stills, CGs, and audio all reside on their respective broadcast devices.  Journalists or producers can 
add these objects into a story or rundown from their workstation.  The actual clip does not get 
copied to the journalist’s workstation, just the metadata -- the details and location -- of the clip.  
The story or rundown is in turn stored on the NCS server.  The server contains information about all 
the rundowns and stories that have been created on all the various workstations, and all the 
metadata stored within them.  The NCS server communicates with the broadcast devices using the 
MOS protocol to control playout of the objects in the stories. 

Pinnacle Systems’ Thunder is just such a broadcast device that can be controlled by the NCS 
server, and can easily be integrated into an ENPS environment.  Clips or stills on a Thunder or 
Lightning server can be dragged into ENPS stories, and rundowns can be created, all from Thunder 
Browse running on an ENPS client workstation. 

 
 

MOS is an acronym for Media Object Server, a communications protocol for control of video equipment by 
newsroom computer systems such as ENPS or iNEWS.  

MOS, the Media Object Server protocol, is used by leading broadcast systems companies to 
link production devices with news production systems, allowing them to seamlessly exchange 
information. MOS can be used to control any device: production video servers such as Pinnacle 
Systems’ Thunder, image management systems like Pinnacle Systems’ Lightning, or audio devices 
and character generators. Associated Press has been the strongest advocate and earliest adopter of 
MOS. Many automation systems vendors are now MOS partners or MOS compliant including 
A.N.N. Automation, iNEWS, Louth, OmniBus, and Proximity. MOS enables users of ENPS®, 
AP’s Electronic News Production System, to control networked Lightning and Thunder systems 
from their desktops or laptops using internet or dial-in connections. 

The term “MOS” has duplicate meanings. It can be used both as the name of the 
communications protocol and also as a generic name for the device which is controlled, as in “The 
NCS can build and transfer playlist information to the MOS.”   For clarity, in this document the 
phrase “Broadcast Device” will be used in reference to the device that is controlled, such as Pinnacle 
Systems’ Thunder, and “MOS” or the phrase “MOS protocol” will reference the protocol.  
For more information on MOS, see the protocol web site at www.mosprotocol.com.  
 
 

ENPS is Associated Press’ Electronic News Production System.  Combining video, text and audio on a 
computer desktop, ENPS links television and radio journalists, production areas and archives in 
multiple locations. This newsroom system offers access to all types of resources, at multiple sites, 
from a single desktop.  ENPS is designed to link multiple newsrooms at separate sites so that news 
resources, including browse-quality audio and video, can be shared throughout a large network. 
For more information on ENPS, please visit the AP’s ENPS website at www.enps.com.  
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ActiveX: ActiveX is a general-purpose Microsoft software technology. Microsoft designed ActiveX to 
facilitate interaction among bits of software written by various vendors.  MOS includes 
specifications for ActiveX controls for newsroom computer systems such as ENPS.  Broadcast device 
vendors such as Pinnacle Systems provide these ActiveX controls which “plug-in” to the ENPS user 
interface so that the broadcast device appears to be part of ENPS. This allows seamless control of the 
broadcast device from a remote machine through ENPS.   
For more information on ActiveX, see Microsoft’s website at 
www.microsoft.com/com/tech/ActiveX.asp  
 
 

Benefits of Thunder with ENPS and MOS 
For a TV station, one of the biggest appeals of MOS is the ease with which it allows news stories to 

be rearranged, and have the associated media assets move with the story. Through MOS, all the broadcast 
devices can be automatically re-synchronized when a news story is added, dropped, or moved, freeing the 
user from manually having to simultaneously regenerate playlists on multiple machines. 

Because the ENPS server controls each broadcast device via the MOS protocol, any change to a 
rundown immediately updates every broadcast device.  A story can be moved, and all the clips, stills, and 
CGs used in that story will automatically be moved with it.  This frees the journalist or producer from 
having to think about the mechanics of putting the news together and allows them to focus completely on 
the actual creation of the news. 

The Thunder and Lightning family Production Clip Servers and Image Management Systems have 
been fully integrated with ENPS to use MOS and ActiveX to deliver exceptional performance and control.  
While the ENPS server drives Thunder playout via MOS, the ENPS client workstations communicate with 
Thunder through ActiveX for content creation.  The ThunderX or LightningX ActiveX controls integrate 
seamlessly into the ENPS application and provide a window into the Thunder database from the journalist’s 
workstation in the newsroom.  Through the ThunderX control the user can insert objects such as clips or 
stills into a story, and view the objects..  

An additional reason that Thunder and Lightning work so well with ENPS is that they have built-
in scheduling capabilities. The ENPS rundown goes right into the Thunder and Lightning sequence via the 
MOS protocol. This is a dynamic sequence that reacts automatically to last-minute changes to the rundown 
while it’s playing on air, allowing the technical director to simply keep taking the next item. 
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How a story is created and used (workflow and data flow) 
The ThunderX ActiveX control appears as a window in the ENPS application, which allows the 

journalist to browse for media clips that are available on the Thunder.  The desired media clips can then be 
inserted into a story, and the journalist would make any other desired changes or additions to the story.  
Once the story is complete, it is then added to a rundown and saved on the ENPS server.  The story can be 
moved around within the rundown and will be played out when its position in the rundown is reached. 

An example of how a journalist or producer would complete these steps, and what data changes as a 
result, can be seen below. 
Insert object into story 
Work done 

A journalist works at an ENPS client workstation that has Thunder Browse software installed. She 
creates a story and edits the script.  An integrated window in the ENPS software shows a Thunder 
database, and at any point she can drag a clip or still from that window directly into her story. 

Data flow 
Information about the added clip is pulled from the Thunder broadcast device by the ThunderX 
ActiveX media control.  These details become MOS object data, which includes information about the 
clip and also the broadcast device from which it will eventually be played back.  The clip MOS object is 
added into the journalist’s story. 
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Story into rundown 
Work done 

The journalist places the story into the rundown. 

 
The producer decides that the story should be 
the fourth story to air and places it in the 
appropriate order.   

 
Data flow 

Each rundown has a matching playlist for each broadcast device that the ENPS server knows about.  
When the story is put into the rundown, the software puts a description of the story’s clip MOS object 
into a matching playlist for the broadcast device. 
The playlists are created automatically from the MOS 
objects that have been dropped into each story.  Due to 
the position of each story in the rundown, and the 
content of the stories before, this specific clip’s MOS 
object is automatically placed in the appropriate order in 
the playlist for the Thunder.  For example the clip for the 
journalist’s story is the third item in the Thunder’s 
playlist. 
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Rundown loaded for playback 
Work done 

As air-time approaches, the producer loads the rundown for playback. 
Data flow 

At this time the playlist 
for each broadcast device, 
including the Thunder is 
sent to that device.  Now 
the Thunder has the 
playlist and knows that the 
clip associated with the 
MOS object is to be aired 
as the third item in its 
sequence for the 6 PM 
news.  
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Last-second changes 
Work done 

During the first story, there is an important piece of late-breaking news, and the journalist’s story is 
bumped down from the fourth story to the eighth story in the rundown. 

Data flow 
The ENPS server creates new playlists for each broadcast device and sends out updates to each device.  
Only the change is sent, not the entire playlist. This is a big advantage over older protocols because it 
allows the playlist to be updated quickly and while still being used on-air.  MOS allows a dynamic link 
to be established between the ENPS server and the broadcast device, to ensure that the sequence of 
items in the production 
equipment always 
matches the producer’s 
rundown. Because the 
story has been moved 
later in the rundown, 
the Thunder will end 
up with a new playlist 
where the example 
clip’s MOS object is 
now the sixth item 
instead of the third 

 
Advance through playlist 
Work done 

There are a number of ways to playback the list that is sent down to the broadcast device, depending 
upon the degree of automation of flexibility that is required. 
For example, there are different ways to handle advancing a production clip server such as a Thunder.  
Many facilities have an operator who will push a TAKE key on a dedicated button box to move through 
the list.  That operator can also call up a “wild’ clip or graphic if there is a last minute addition. 
Other facilities use the “tally low” signal from the switcher to trigger the Thunder, so that the Thunder 
is automatically advanced whenever the technical director takes the Thunder clip server off the program 
channel. 
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Installation and Configuration 
 

Setting up a Thunder system in an ENPS environment requires three steps: setting up the Thunder 
broadcast device to communicate with the ENPS server via MOS, installing the ENPS client software on a 
workstation, and configuring that workstation to use Thunder Browse and the ThunderX ActiveX control. 
 
Installation of ENPS Client 

Please see your system administrator for installation of the ENPS client.  The system administrator 
must add you as a new user to the ENPS user database before you can log in to ENPS, and can also 
verify that the ENPS client is licensed properly. 

 
 
Setting up the Thunder/Lightning broadcast device 

1. Configure a MOS connection using File > Preferences > Protocol Setup. 

2. Select MOSProtocol, select a channel, type in IP address of ENPS server, and select a database.  (For 
details on determining the IP address of the ENPS server, see Appendix C: Getting IP Addresses.)  
If you want MOS to be playable by GPIs, select a GPI trigger under MOS GPI. ThunderX uses the 
computer name as the MOS ID to identify the Thunder.  If you wish, you may now assign a 
different name in the MOSID field. Click on Restart or Restart All, then OK. 
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3. If you selected a MOS 

GPI, the GPIs must also 
be configured from File > 
Preferences > Assign 
GPIs.   

4. Set this trigger to issue a Play Next 
Event command. 
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5. Also, turn the GPIs on using File > Preferences > Enable GPI triggers. 
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Setting up ENPS Client to use ThunderX 
ThunderX 

Install ThunderX on the client machine by running either the Thunder Browse or ThunderX installer.  
 
  
ENPS client 

1. To configure the ENPS client to see the ThunderX ActiveX control, click on the fourth folder’s 
rover (the green dot in the upper left of the folder) and select System Maintenance > MOS 
configuration.   Click New in the resulting dialog. 

 
 

2. Add a new ID. The ID can either be 
the computer network name of your 
Thunder or Lightning or a different 
name that you set up in the MOSID 
field in the Protocol setup (see step 2 
in the section Setting up the 
Thunder/Lightning Broadcast Device 
above).   
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3. Double-click anywhere on the new row and enter the following values: 
• Description: A description to help you 

identify your Thunder  
• IP: IP address of Thunder/Lightning 

broadcast device.  (For information on 
how to obtain the IP address, see 
Appendix C: Getting IP Addresses.) 

• ActiveX = ThunderX.ThunderXctrl.1 
for Thunder running version 5.2 or 
later, or LightningX.LightningXctrl.1 
for Lightnings or if you are running 
Thunder version 5.1 or earlier. 

• Program: Enter the folder ID for the 
ENPS folder where the Thunder MOS 
items will be stored. 

• Default Settings: If you are setting up 
more than one Thunder, ENPS can be 
set up so that ThunderX can switch 
between the different Thunders easier.  
The database information for each 
Thunder is now saved and used to bring 
up the correct settings and database 
when a specific Thunder is accessed.   
This setting is only necessary if you have more than one Thunder and wish to switch between 
them.  If you are only running one Thunder, or do not wish to switch between multiple 
Thunders using MOS, then configuring this setting is not necessary. 
In the Default Settings box assign the machine name of each Thunder.  You must add 
“USERID=name” including the quotation marks (where ‘name’ is your Thunder name) into 
the Default Settings field. 

• Local DragDrop: OFF 
 

 
4. Click on the Media rover and select the desired 

Thunder or Lightning broadcast device. 

 
 
 
5. In the Setup Menu dialog, enter the computer name of the Thunder or Lightning broadcast device 

in the Pinnacle Clip Server Computer Name (MosID) field.  If you wish to browse the network to 
find the broadcast device name, click on the ellipsis (“…”) button. 
Also add the path to the desired database in the Database Path/Name field.  If you wish to browse 
the network to find the database path name, click on the ellipsis (“…”) button.  
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The dongle ID and the password are the ID and password of the dongle on the Thunder server.  
The number of ThunderX client licenses will be controlled by the dongle on the server, and will be 
determined by the number of client licenses that you purchased. 
Enter the Dongle ID and Password from the dongle on the Thunder or Lightning broadcast device, 
not the dongle on the client Browse workstation.  See step 6 for information on reading the dongle 
password. 

 
 
6. To get the dongle ID and password 

from the Thunder broadcast device, you 
will need to be at the desired machine 
running the Thunder software.  Go to 
File > Preferences > Options…  The 
easiest way to correctly transfer the 
password from the Thunder broadcast 
device to the client Browse workstation 
is to copy the password into a text file 
and open and read the file across the 
network. 

 
7. Once this setup information has been entered, it should not need to be reconfigured.  However, if 

the dongle is removed, or for any other reason the data has changed, the warning dialog will appear 
and the setup information will 
need to be reconfigured. 
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8. If you want to change the database you will be able to do it at 
any time while in the ThunderX application by pressing F9 or 
clicking on the Advanced button in the Options dialog.   

 
 
9. If you want to change the database you will be able to do it at any 

time while in the ThunderX application by pressing F9.  After 
you have entered the dongle password or ID, or changed the 
database, you will need to close ThunderX and restart it. 

 
 

10. The database will open in a window in the bottom edit window of the ENPS client software.   
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Using MOS in a Live-to-Air Environment  
 

This is a brief description of one possible way to create a new story and rundown and play to air.  ENPS is a 
considerably flexible program that enables the user to perform different steps to create the same result.  For 
more information, refer to the sections “Writing Stories” and “Using MOS” in the ENPS Help. 
Create a story 

1. Simply drag a MOS object into the upper-right edit window to start a new story. 

 
2. Write the script for the story. 

 
3. Retitle the script by double-clicking on “Untitled” in the 

tab above the story, then type in a name and hit enter. 

 
4. The new title is displayed in the tab. 

 

 

Using MOS and ENPS with Thunder  Page 17 of 32 
Sep 2002 - Steve Kang, Product Manager, Live To Air Storage  PPN 327WPENPS Rev. C 



Add story to rundown 
1. Create a new rundown by clicking 

on the third folder’s rover and 
selecting New > Rundown. 

 
2. Add a title for the rundown in the Program field, and make any other changes, such as start or end 

times. 
Click on Go. 
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3. The new rundown is displayed along the top of the window. 

 
 

4. Add story to the rundown simply by dragging the tab of the story into the rundown list.  The story 
name will appear in 
the Story Slug column. 

 
 
5. Add other stories to the rundown if desired.  

The stories can also 
be repositioned into 
a different order. 

 

 

Using MOS and ENPS with Thunder  Page 19 of 32 
Sep 2002 - Steve Kang, Product Manager, Live To Air Storage  PPN 327WPENPS Rev. C 



Play to air 
1. When the rundown is ready to be played to air, click on the 

rundown rover and select Properties. 

 
2. Click in the MOS Control Active box.  Make sure that a ‘+’ appears in the box. 
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3. The MOS Status column will change from blank to “NOT READY” with a red background.  This 

indicates that there is MOS communication with the Thunder broadcast device, but that rundown is 
not ready to air. 
The results that occur on the Thunder are that a new sequence has been created with the clips, but 
it has not yet been cued. 

 
 

4. Click on the rundown rover and select MOS Ready to air. 

 
5. Setting the rundown ready to air cues the sequence on the Thunder.  The MOS Status column 

should display “READY.” 
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6. Note that any stories that are above the black line are considered active.  Stories can be dragged from 
below the black line to above the black line and automatically added to the rundown.  
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Features 
Searching: The F4 searching feature has been added to ThunderX.  Selecting inside the database view 
and pressing F4 will bring up the familiar Thunder search dialog.   Enter a search criteria and click 
OK and the window will show the filtered results.   

 
To return to a full database view, press F4 again 
and then click on the Clear button and then OK 
again.  This will clear all search filter criteria and 
show all items in the database. 

 
NOTE: If the previous search did not yield any 

results, then to bring up the search 
dialog again, you must click on the 
column headers then press F4. 

Jump to a clip: Enter the number of a clip on the nunber 
keypad, and that clip or still will be immediately selected. 
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Show clip in story: To see the clip that is in a story, 
double-click on the story in the rundown.  The story 
will appear in the upper-right edit window. 

 
Double-click anywhere on the MOS tag for the item, and the clip 
will be highlighted in the ThunderX database window. 

 
Options 
The Options button is in the upper-right corner 
database.   

 
Clicking this button brings up a menu which controls certain 

ptions for viewing and playing out items in the database. Just 
e database on the Thunder itself, the picons can be 

perties controls the playout manner of the clips.  
Currently cuts are the only transition available.  Transition 
duration (TransDur) does not affect cuts. 
The Advanced button will bring up the Setup Menu.  For more 
information, see “Setting up ENPS client to use ThunderX.

 

of the edit window of the Thunder 

o
as in th
viewed in three different sizes and with or without clip details. 
Event Pro

” 
“Apply” must be clicked before “Close” for changes to take 
affect. 
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Tiny picons without 
details. 

 
Tiny picons with 
details. 

 
Small picons without 
details. 
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The Event Propertie
sequenc

s can change how the clip plays out from the Thunder 
e that is created from the rundown.   

 

 
Control offers either Manual or Follow, where Manual requires a manual take to 
play the next item in the sequence and Follow automatically plays the next item. 

 

Versions: 
This document applies to ThunderX 5.0.0.11.  This can be found by 
clicking on the Pinnacle icon in the upper left corner of the database view. 
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Appendix A: MOS Frequently Asked Questions 
 

MOS is an acronym for? 
MOS is short for Media Object Server Communication Protocol. The MOS Protocol is intended to be a 
global industry solution to the problem of "How do I get my brand-X computer system to 
communicate with my brand-Y media server?" 
 

What does MOS do? 
Media Object Server Communications Protocol allows Newsroom Computer Systems (NCS) and Media 
Object Servers (MOS) to exchange information using a standard protocol (language and vocabulary).  
This protocol enables the exchange of the following type of messages:  

1. Descriptive Data for Media Objects.  The MOS "pushes" descriptive information and pointers 
to the NCS as objects are created, modified, or deleted in the MOS.  This allows the NCS to be 
"aware" of the contents of the MOS and enables the NCS to perform searches on and manipulate the 
data the MOS has sent.  
2. Playlist Exchange.  The NCS can build and transfer playlist information to the MOS.  This 
allows the NCS to control the sequence that media objects are played or presented by the MOS.  
3. Status Exchange.  The MOS can inform the NCS of the status of specific clips or the MOS 
system in general.  The NCS can notify the MOS of the status of specific playlist items or running 
orders.  

 
What is a "MOS?" 

A Media Object Server (MOS) is any device capable of storing Media Objects.   
 

What are Media Objects? 
Media Objects are defined as:  

1. CGs (Character Generator Objects)  
2. Audio  
3. Still Store  
4. Video  

It is generally assumed, though not a requirement, that these objects will be stored in a non-linear 
device. 
Other types of Media Objects may be later added to this list. 
 

What is the NCS responsible for? 
In General, the Newsroom Computer System is responsible for the creation, modification, and deletion 
of editorial information, including playlists 
 

What is the MOS responsible for? 
In General, the Media Object Server is responsible for the creation, modification, and deletion of media 
objects and their associated meta-data. 
 

www.mosprotocol.com 
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Appendix B: ENPS Questions & Answers 
 

What is ENPS?  
ENPS is the world’s most advanced electronic news production system. Its development followed a 
two-year effort by the British Broadcasting Corporation to replace its existing newsroom computer 
system with a state-of-the-art successor. The BBC competition, in which more than 50 information 
technology companies participated, was won by The Associated Press, and ENPS is an AP product. 
The BBC's television and radio operations in the United Kingdom, along with BBC News and Current 
Affairs and BBC World Service, have more than 12,000 users working in 48 languages. Combining 
text, audio and video on each BBC desktop, ENPS will be the largest broadcast newsroom computer 
system in the world, linking radio and television journalists, production areas and archives in more 
than 100 locations. This new technology -- the first newsroom system ever to offer access to all types of 
resources, at multiple sites, from a single desktop – is being expanded to meet the needs of news 
organizations worldwide. 
ENPS is designed to link multiple newsrooms at separate sites so that news resources, including 
browse-quality audio and video, can be shared throughout a large network. It uses standard hardware 
running Microsoft Windows. 

 
How do I obtain the latest information about ENPS? 

AP has created a Web page as an electronic distribution point for updates to this Q&A, product 
backgrounders and news releases. You can always get up-to-the-minute ENPS information on the 
Internet at http://www.enps.com, or you can request information via fax from London on +44 (0)20 
7482 7801 or Washington on +1-202-736-1124. 

 
What are the key features of ENPS?  

ENPS combines standard hardware and operating systems with a unique, intuitive user interface, 
allowing journalists to use "drag and drop" techniques for almost every function. Rather than limiting 
access to material in a single newsroom, ENPS allows users to work with information from any 
newsroom in the organization, in any format.  
All the standard features of large newsroom systems – news wires, scripting, rundowns, archives, 
assignments, production device control – are included. Among the ENPS enhancements that 
journalists are sure to notice are:  

• No menu or tool bars and no confusing command lines to take up screen space.  
• Quick searching of all news resources, no matter what type, with a single query.  
• Video and audio playback within the same workspace as text handling.  
• Consistent interface and functionality.  

 
How will ENPS improve my news operation? 

ENPS cuts training and support costs, reduces the time it takes to research a topic, makes better use of 
archives and other expensive news resources, and ensures journalists get the whole story, not just the 
pieces that are easiest to locate in the local newsroom. Your staff will come to see their ENPS 
workstations as tools that are just as essential as cameras, microphones, and traditional notebooks. 

Do I need to install a new network for ENPS?  
ENPS is designed to work with any TCP/IP network, whether it is a LAN or a WAN. If your network 
currently does not use the TCP/IP protocol, then it is likely to be due for an upgrade anyway, allowing 
you to take full advantage of Internet and intranet applications.  
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Other applications running in conjunction with ENPS, such as audio or video editing devices, may 
require greater bandwidth than standard 10mb Ethernet. 

 
 
www.enps.com/products/enps/q-a.asp 
 
 
Copyright © 2001, The Associated Press. All rights reserved. ENPS, GraphicsBank, Associated Press and AP are registered trademarks of 
the Associated Press. Other products and company names mentioned herein may be the trademarks of their respective owners. The 
Associated Press may have patents, pending patent applications, trademarks, copyrights or other intellectual property rights covering subject 
matter in this document. The furnishing of this document is not a license to these patents, trademarks, service marks, copyrights or other 
intellectual property rights except as expressly provided in any written license agreement from the Associated Press. 
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Appendix C: Getting IP Addresses  
 

There are two easy ways to determine the IP address of a machine.  Both ways are accessed from the 
Command prompt.  Go to Start > Run and type in “cmd”. 
If you are at the machine of which you wish to determine the IP address, type ipconfig and press enter.  
This will provide the IP Address of the machine, in this example 10.22.1.29. 

 
If you wish to determine the IP address of a remote machine on the network, type ping and the network 
name of the desired machine, e.g. “ping enps_server”. 
This results in the output  
Pinging enps_server [10.22.1.26]…  
which reveals that 
the IP address for 
enps_server is 
10.22.1.26  
 

 
Many NT networks use a DHCP server to assign IP addresses, rather than giving fixed addresses to each 
machine. Under DHCP, the IP address for each machine is dynamically allocated, meaning that it can 
change.   However, our experience has been that these addresses are stable, especially if the machine is left 
on. 
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How to Contact Pinnacle Systems 
 

 
Pinnacle Systems can be reached via World Wide Web, telephone, email, and “snail-mail.” When calling 
for technical support, first obtain information on your system from the Help > About. 
 
Pinnacle Systems, Inc. 
280 N. Bernardo Avenue 
Mountain View, CA 94043 
 
 
Whenever contacting Pinnacle Systems for technical support, please have the information available: 
 

• Product name  

• Product Serial Number 

• Version:  Version number may be located by clicking on the Pinnacle logo in 
the upper-left hand corner of the edit window. 

• Type of Defect:  Crash, Video Glitch, Bug/Doesn't work right, Feature Request, or 
Usability/Improvement. 

• A precise description of the problem. 

• Exact steps to repeat the problem (even if it's 15 steps), if it can be reproduced. 
 
 
 
 

 Broadcast Support Americas and Canada 
Phone: Domestic (866)753-0491 Int'l 406-676-3385 
Fax:  (650) 930-1601 
Hours: 6am – 6pm (M-F) Pacific Time 
Email: broadcast-support@pinnaclesys.com 
Web Support: www.pinnaclesys.com/support 
  
 Broadcast Support Europe 
Phone: (44) (0) 1895 442-003  
Fax:  (44) (0) 1895 442-275 
Email: broadcast-support-uk@pinnaclesys.com 
Web Support: www.pinnaclesys.com/support 
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 Broadcast Support South Asia 
Phone: (65) 284-2336  
Fax:  (65) 285-9486 
Email: pacrim-support@pinnaclesys.com 
Web Support: www.pinnaclesys.com/asia 
Supports Regions: Taiwan, India, Pakistan, Bangladesh, Sri Lanka, Australia, New Zealand, 

Thailand, Viet Nam, Philippines, Brunei, Singapore, Malaysia, Indonesia 
  
 Broadcast Support Beijing 
Phone: (86) 10 6641 0053 or (86) 10 6641 0063  
Fax:  (86) 10 6641 0073 
Email: broadcast-support-cn@pinnaclesys.com 
Web Support: www.pinnaclesys.com/asia 
Supports Regions: China, Hong Kong, Korea 
 
 

 

 Pinnacle Systems Corporate  
Website: http://www.pinnaclesys.com 
Mailing Address: Pinnacle Systems, Inc. 

Attn: Broadcast Support 
280 N. Bernardo Avenue 
Mountain View, CA  94043-5238 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pinnacle Systems, Inc. cannot be held as responsible for the information in this document.  
 
This document is for information purposes only. Pinnacle Systems, Inc. makes no warranties, expressed or implied, in this document.  
 
All trademarks and registered trademarks are the property of their respective owners and are used for identification or reference purposes only, 
with no intent to infringe on copyrights. All original content is copyright © 2002, Pinnacle Systems, Inc. 

mailto:pacrim-support@pinnaclesys.com
http://www.pinnaclesys.com/asia
mailto:broadcast-support-cn@pinnaclesys.com
http://www.pinnaclesys.com/asia
http://www.pinnaclesys.com/
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